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What is spreadsheet? 
A spread sheet can be defined as a table of values arranged in rows and columns. It can be described 
as being like a large sheet of graph paper and used to store large tables of numbers and text. 
Spreadsheets provide tools for working with numerical data.  

They can be use a spreadsheet program to create budgets, balance sheets, and other types of number-
based documents. You can display your information in a traditional row-and-column format, or in a 
chart.  

Spreadsheets can be used for storing and amending accounts, “what if?” financial projections, and 
many other applications involving tables of numbers with interdependent rows and columns. 

A spreadsheet is often a component of an integrated office system. Examples include Microsoft Office 
Excel, Lotus 1-2-3 and Quattro Pro. 

What is Microsoft Office Excel 2007? 
Microsoft Excel is a spread sheet program that can be used to track of lists, numbers and statistics, 
such as might be used in accounting. 

Microsoft Word   file  is  called  “documentation”   and   its   file  consist number of  Pages, but  
Microsoft  Excel   file  is  called  “Workbook”  and   its  file  consist number of  sheets. 

Microsoft Excel 2007 file format is .xlsx 

Terminology 
Cell: a single value in the spreadsheet at the intersection of a row and a column. Cells are named 
using both row and column (e.g. A1, G456). A cell may contain either a label (text, up to 32KB), a 
number (literal number or date), or a formula. 

Row: a horizontal sequence of cells. Rows are numbered starting with 1 through 65536. 

Column: a vertical sequence of cells. Columns are lettered starting with A through IV. 

Range: a rectangular group of cells. Ranges are delimited by the top-left and bottom-right cells, and 
are specified by naming the top-left cell, a colon, and then the bottom-right cell (e.g. B4:F16). 

Worksheet: the 2-dimensional grid of cells from A1 to IV65536. 

Workbook: a set of worksheets (by default, 3) that are saved together as a single .xlsx file. 

Name Box: located at the top-left of the screen, the Name Box displays the name (column/row) of the 
selected cell. You may also name a cell or range by first making a selection, and then typing in the 
name inside the Name Box. 

Formula Bar: the textbox at the top of the screen, to the right of the Name Box. Cell values may be 
changed in this space, or directly in the cell itself. Selecting a cell with a formula will display the 
formula in the Formula Bar, while the numeric result of the formula is displayed in the cell. 
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Introduction to Microsoft Excel 2007 
Microsoft Excel 2007 is a software application that can be used a spreadsheet for creation of 
small databases, data management, or for chart creation.   The electronic spreadsheet portion of 
Excel allows the users to perform sophisticated calculations and the creation of formulas that 
automatically calculate answers.  Data management capability allows the manipulation of lists 
of information such as names, addresses, inventory items, prices, etc.  The information created 
in an Excel spreadsheet or database can be used to create Excel charts. 
 
This guide is an introduction to Excel2007 and illustrates the basic functions the program 
offers.  
 
Launching Excel 2007 
 

 
To start Excel 2007 in the Open Access Labs: 

1.   Click the Start button at the bottom left corner of the screen. 
2.   Select the All Programs option. 
3.   Select the Microsoft Office folder. 
4.   Click the Microsoft Excel2007 icon. 
 
 
Working with the Excel Interface 
Excel launches with a new blank workbook with three blank worksheets (see Figure 1).  The 
Title Bar displays the name of the current workbook and the name of application.  By default, 
a new blank workbook is called "Bookl" and the three blank worksheets are named 
“Sheetl," "Sheet2," and "Sheet3." A workbook is a collection of individual worksheets. 
A worksheet is a grid composed of 256 columns and 65,536 rows. The intersection of a row 
and column is called a cell.  Cells are used to store data entries.  Each cell is referred to by its 
cell address consisting of the column letter and the row number.  For example, the address of 
the cell in the first column and the first row of a worksheet is "Al." The active cell is the 
currently selected cell where data can be enter and edited.  The active cell has a thick black 
border around it, and its address appears in the Cell Name Box.  Only one cell can be active 
at a time.  Excel2007 includes many enhancements to make working with the workbook and 
worksheets easier, and to make it more professional looking.  Refer to Table 1 for a brief 
description of each item. 
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Table 1 - Excel Interface and Components 
Item Description
Title Bar Contains the title of the workbook and the application 
Office button Grouping of commands to save, open, print and perform 

other commands common to all Office applications 
Quick Access 
Toolbar 

Collection of buttons to quickly access regularly used 
features of the application 

Ribbon Contains many features formerly found in menu structures 
Tabs Individual collections (groups) of commands within the 

Ribbon 
Scroll Bars Move around a worksheet, up or down, left or right 
View Options Excel 2007 provides several different ways to view a 

workbook 
Dialog Launcher A control for accessing more features contained within a 

group on the Ribbon 
Worksheet Tab Indicates the worksheet name and which worksheet is 

active 
Zoom Control Controls the magnification of the slide 
Cell Name Box Indicates the active cell or the upper, left cell in a 

range of cells. 
Formula Bar Indicates the data value in a cell, or a formula (if 

present) 

The redesigned user interface includes the components illustrated in Figure 1. 

 
Figure 1 - The Excel Interface 

USING THE OFFICE BUTTON 
Excel provides a collection of commands common to all Office applications that are grouped 
under the Office Button. The Office Button replaces the File menu that was found in previous 
versions of Microsoft Office. Clicking the Office Button (see Figure 2) will open a dialog box 
displaying the commands available (see Figure 3). In addition, Excel can be customized by 
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clicking the      button at the bottom of the dialog and selecting or deselecting the 
options available. 

 
Figure 2 - The Office Button 

 
Figure 3 - Commands within the Office Button Group

USING THE QUICK ACCESS TOOLBAR 
The Quick Access Toolbar is located above the Ribbon and contains common, frequently used 
commands. The commands available from the Quick Access Toolbar are always visible, which 
eliminates searching through the Ribbon or tabs (see Figure 1).  

MINIMIZING AND MAXIMIZING THE RIBBON 
Users can minimize the Ribbon, which will allow more of the slide to be visible in the active 
window. When minimized, only the tabs will be visible. All of the commands within the groups 
of each tab on the Ribbon will still be available. 

To minimize the Ribbon: 
1. Click the Customize Quick Access Toolbar drop-down arrow  . The Customize Quick 

Access Toolbar menu will open (see Figure 4). 
2. Select the  menu item. The Ribbon will be concealed.  
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Figure 4 - Customize Quick Access Toolbar Menu 

To use commands in the Ribbon while minimized: 
1. Click the tab where the command is located. The Ribbon will re-appear. 
2. Click the tab again and the Ribbon will be concealed. 

To maximize the Ribbon: 
1. Click the Customize Quick Access Toolbar drop-down arrow   . The Customize 

Quick Access Toolbar menu will open (see Figure 4). 
2. Click the    menu item. The Ribbon will reappear.  

USING DIALOG BOX LAUNCHERS 
Dialog Box Launchers    are a new feature in Excel 2007. These buttons appear in most (but 
not all) of the command groups of the Ribbon in each tab. If a group has a Dialog Box 
Launcher it will be located in the lower right corner of the group. Clicking a Dialog Box 
Launcher opens a specific dialog box that is relevant to the group. 

Creating and Saving Workbooks 
Whenever the Excel application is launched from the    menu, a new blank workbook 
opens. Users can also create new workbooks while existing workbooks are open. Once a 
workbook is opened or created, data can be entered by clicking inside a cell and using the 
keyboard.  Pressing the [Enter] key will automatically move the insertion point to the beginning 
of the cell in the next row, but in the same column.  

NOTE: If the [Enter] key is not pressed and the amount of information exceeds the visible cell width, the 
cell will take on an overflow appearance with the column separator lines not visible (see Figure 5) 

 
Figure 5 - Example of Cell A1 with Overflow 
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To create a new workbook while an existing workbook is open: 
1. Click the Office Button (see Figure 2) then click the New    button in the available 

options. The New Workbook dialog box opens (see Figure 6). 
2. Click the    button in the Templates column of the dialog box. 
3. Select the    option in the Blank and recent section of the dialog box. 
4. Click the    button. A new blank workbook will open in a Microsoft Excel 

window independent of the existing workbooks. The dialog box will close. 

Figure 6 - New Workbook Dialog Box 

To save a new workbook for the first time: 
1. Click the Save button     on the Quick Access Toolbar. The Save As dialog box opens 

(see Figure 7). 
2. Enter a name for the workbook in the     text box. 
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Figure 7 - Save As Dialog Box 

NOTE: By default, workbooks are saved in the My Documents folder on the main drive of the 
computer. If the user wants to save the workbook in a different folder or drive, click the   
drop-down arrow and select a different location. 

3. Click the    button to save the file. The dialog box will close. 

NOTE: By default, workbooks are saved with a file extension of .xlsx. This extension makes the 
workbook compatible only with Excel 2007. If this file extension is used, the workbook will not open 
in previous versions of Excel (97, XP, or 2003). If the user wants the workbook to be compatible with 
previous versions of Excel then the Save As option should be used as described below. 

NOTE: After a workbook has been saved for the first time, clicking the Save button     on the 
Quick Access Toolbar will save any changes without the Save As dialog box opening. 

USING SAVE AS 
The Save As option allows a user to save a new or existing workbook in a different format other 
than the default Excel 2007 format. This can eliminate workbook incompatibility with users who 
do not use Excel 2007. 

To use the Save As option: 
1. Click the Office Button to display the commands within the Office Button group. 
2. Hover the mouse over the Save As button to display the options available (see Figure 8). 
3. If compatibility with previous versions of Excel is desired, select the 

  option. The Save As dialog box will open with the Excel 97-2003 
file format automatically selected. 

4. If a different format is desired (such as a template or web page format) then click the 
  drop-down arrow and select the appropriate format. 

5. Enter a name for the file in the    text box. 
6. Click the    button to save the workbook in a different format. 
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Figure 8 - Save As Options 

Opening an Existing Workbook 
After creating and saving a workbook, the file resides on a disk. To view or edit an existing 
workbook, it must first be opened from the disk. 

To open an existing workbook: 
1. Click the Office Button. 
2. Click the Open button in the list of available options (see Figure 3). The Open dialog box 

appears (see Figure 9). 

NOTE: If the desired workbook is not in the default folder, click the    drop-down arrow and 
navigate to the appropriate folder and/or drive. 
3. Click on the workbook name and, if necessary, click the    button. 
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Figure 9 - Open Dialog Box 

Basic Workbook Skills 
Worksheets consist of rows and columns. To navigate a worksheet, standard navigation keys on 
the keyboard can be used. 

WORKING WITH COLUMNS AND ROWS 
Columns and rows are used to store information in Excel. Usually columns represent the field 
common for each individual entry, and rows represent the list of the entries.  For example, a 
column can contain grades of students on a final exam, while rows contain the list of students in 
the class. 

Selecting a Column and Row 
Users must select columns and rows to perform functions such as formatting rows or columns, 
changing the width of several columns at a time, changing the height of several rows at a time, or 
inserting and deleting columns or rows. 

To select a single column, click the desired column header, to select a single row, click the 
desired row indicator. 

To select both a column and a row as in Figure 10: 
1. Click the desired column header. 
2. Hold the [Ctrl] key and click the desired row indicator. 
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Figure 10 - Selecting Rows and Columns 

Inserting a Column 
A newly inserted column will appear to the left of the active (selected) column. 

To insert a column: 
1. Right click a cell in the column next to where the new column will be inserted. 
2. Select the   command from the menu. The Insert dialog box opens (see Figure 11). 
3. Click the    option button. 
4. Click the OK button. A new column will be inserted. 
OR 
1. Right-click the mouse button on the column header. 
2. Select the   option. 

 
Figure 11 - Insert Dialog Box 

 
Figure 12 - Delete Dialog Box 

 
Figure 13 - Name Box 

Inserting a Row 
A newly inserted row will appear above the row that is active (selected). 

To insert a row: 
1. Right click a cell in the row above where the new row will be inserted. 
2. Select the    command from the menu. The Insert dialog box opens (see Figure 11). 
3. Click the    option button. 
4. Click the OK button. A new row will be inserted. 
OR 
1. Right-click the mouse button on the row indicator 
2. Select the    option. 
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Deleting Columns and Rows 
To delete a column: 

1. Right click a cell in the column.  
2. Select the    command. The Delete dialog box opens (see Figure 12).  
3. Select the    command. 
4. Click the OK button. 
OR 
1. Right-click the mouse button on the column header.  A shortcut menu appears. 
2. Select the    command. 

To delete a row: 
1. Right click a cell in the row.  
2. Select the    command. The Delete dialog box opens (see Figure 12).  
3. Select the    command. 
4. Click the OK button. 
OR 
1. Right-click the mouse button on the row indicator.  A shortcut menu appears. 
2. Select the    command. 

NAVIGATING THE WORKSHEET 
Users can use the keyboard to navigate between cells in a worksheet (see Table 2). 

 Table 2 - Navigating the Worksheet 
Action Description
One Cell At A 
Time  

Use the [Arrow] keys on the keyboard to move up, down, 
left, or right.  The [Enter] key can be used to move down, 
the [Shift+Enter] combination can be used to move up, the 
[Tab] key can be used to move to the right, and the 
[Shift+Tab] combination can be used to move left. 

One Screen At A 
Time (Up and 
Down) 

Press the [Page Up] and [Page Down] keys to move up or 
down one screen at a time.  The active cell will move up 
or down as indicated. 

One Screen At A 
Time (Left and 
Right) 

Press the [Alt+Page Down] keys to move one screen to the 
right; and press the [Alt+Page Up] keys to move one screen 
to the left.  The active cell will move right or left as 
indicated. 

USING THE NAME BOX 
The Name Box (see Figure 13) can be used to navigate to a specific cell. Clicking inside the 
Name Box will highlight the contents. Typing in a specific cell address and pressing the [Enter] 
key will move the active cell to that address. 

ENTERING DATA 
Data can be text or numeric. Text is defined as any combination of numbers and letters.  
Numeric entries are limited to numbers. Numbers can exist as independent values or as values 
derived from a formula. 

Entering Text 
Text will automatically align to the left in a cell.  If the length of the text is greater than the width 
of the column, it will appear as if it is occupying adjacent cells (see Figure 14). When text is 
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entered into the adjacent cell, the long text entry appears as if characters have been deleted (see 
Figure 15 (the characters have not been deleted and will appear if the width of the column is 
adjusted to accommodate the entry) (see Changing Column Width section of this handout). 

 
Figure 14 - Apparent Content Overflow 

 
Figure 15 - Apparent Content Deletion 

To enter text: 
1. Click in the cell in where the text will be entered. 
2. Type the text into the cell.  The text will also appear in the Formula bar. 
3. Press the [Enter] or the [Tab] key to exit the cell 

Entering Numbers 
Numbers are automatically aligned to the right in a cell.  To enter a negative value, type a minus 
[-] sign before the number or enclose the number in parenthesis. Decimals are indicated by 
typing a period [.] and typing numeric values after.  Additionally, dates are considered numeric 
values that can be manipulated through mathematical calculations.  (See Formatting 
Numbers for further information). 

To enter number: 
1. Click in the cell where the data will be entered. 
2. Type the number into the cell.  The number will also appear in the Formula bar. 
3. Press the [Enter] or the [Tab] key to exit the cell 

ENTERING A LINE BREAK INSIDE A CELL 
Users may want to add several lines of data into a cell.  It is possible to control the line breaks for 
multiple-line headings or labels in Excel, similar to Microsoft Word (see Figure 16). 

To enter a line break inside a cell: 
1. Click the cell where the label or heading will be added. 
2. Type the first line of information. 
3. Press the [ALT+Enter] key combination 
4. Type the second line. 
5. Repeat the steps 3 and 4 if there are additional lines that 

need to be entered. 
6. Press the [Enter] key when finished. 

 
Figure 16 - Example of a Cell with 

Line Breaks 

CELL RANGES 
A group of selected cells is called a range (see Figure 17).  The range is identified by the 
addresses of the first and last cell. 

To select a range: 
1. Click the first cell in the range to be selected. 
2. Drag the pointer across the range of cells to select. 
3. Release the mouse button.  The range of cells will be highlighted. 
OR 
1. Click the first cell in the range to be selected. 
2. Hold down the [shift] key and click in the last cell of the range. 
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NOTE: It is also possible to use the combination of keyboard and mouse to select nonadjacent ranges. 
To select nonadjacent cells, select the first group of cells, hold the [Ctrl] key down on the keyboard 
and select the nonadjacent group of cells (see Figure 18).  

 
Figure 17 - Adjacent Range of Cells 

 
Figure 18 - Nonadjacent Range of Cells 

Entering Data in a Range 
Select the range in which data will be entered (follow the steps above).  The range of cells must 
be highlighted. 

In an adjacent range of cells, the data being entered will automatically begin at the first cell in 
the range.  To begin entering data into a cell other than the first in the range, press the [Tab] key 
to move to the right; press the [Shift+Tab] keys to move left; press the [Enter] key to move 
down; or press the [Shift+Enter] keys to move up. 

EDITING CELL DATA 
Once data have been entered into a cell, the contents of the cell can be modified by editing, 
deleting, copying, or pasting.  If data are entered into a cell that already has an entry, the new 
entry will replace the old one.  Users do not have to be in edit mode. 

To edit cell entries: 
1. Double-click a cell.  Excel will shift the cell into edit mode with the content appearing in 

the Formula bar. 
2. Cell can be edited in the cell itself or in the Formula bar. 

Deleting Cell Data 
To delete cell data: 

1. Select the cell or cell range to delete. 
2. Press the [Delete] key on the keyboard. 

Copying and Moving Cell Data 
In addition to typing data into cells, users can also copy or move data from a cell or range of 
cells to another.  Copying and pasting cell data leaves the data in the original cell(s) and 
duplicates it into the target cell(s). Cutting and pasting cell data moves the data from the original 
cell(s) and places it into the target cell(s). 

To copy and paste: 
1. Select the cell or the cell range to copy (see Cell Ranges). 
2. Select the Home tab on the Ribbon. 
3. Click the Copy button    in the Clipboard group. A blinking marquee appears 

around the selected cell or range (see Figure 19). 
4. Select the target cell or range into which to paste the copied cell content. 
5. Click the Paste button in the Clipboard group (see Figure 20). 
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6. Press the [Esc] key to remove the blinking marquee. 

 
Figure 19 - Cells with Marquee 

 
Figure 20 - Paste Button 

To cut and paste: 
1. Select the cell or the cell range to cut. 
2. Click the Cut button    on the Standard toolbar.  A blinking marquee appears 

around the selected cell or range (see Figure 19). 
3. Select the target cell or cell range into which to paste the cut cell contents. 
4. Click the Paste button in the Clipboard group (see Figure 20). 

Undo and Redo 
If the user makes a mistake or desires to cancel an action just performed, it is possible to undo or 
redo it. The Undo feature allows undoing the results of a previous command or action. 

To undo an action: 
1. Click the Undo button    in the Clipboard group. The user may click the Undo button 

as many times as needed in succession. 

Once the Undo feature is used, the Redo feature becomes available.  It restores the results of 
actions that were undone with the Undo feature. 

To redo an action: 
1. Click the Redo button  in the Clipboard group. 

Formatting a Worksheet 
Formatting the characters in a worksheet can enhance the appearance of the worksheet and 
provide a more professional appearance to the entire worksheet. 

LIVE PREVIEW 
Live Preview is a new feature in Excel 2007. In the case of character formatting, Live Preview 
applies to the Font typeface, Font size, and Font color. Live Preview allows the user to visualize 
how a different typeface, size, or color will appear within the document. Live Preview 
temporarily displays any changes to a selected object or selected text in the document without 
actually changing it. 

THE MINI TOOLBAR 
Another new feature in Word 2007 is the Mini Toolbar. The Mini Toolbar contains frequently 
used formatting commands and appears in a semi-transparent mode whenever text is selected for 
formatting. Moving the mouse over the toolbar activates it and makes the options available for 
use (see Figure 21). Most of the formatting options on the Mini Toolbar are discussed in the 
following sections. 
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CHARACTER FORMATTING 
Character formatting enhances the appearance of text, and includes font typeface, font size, font 
style, and font color. Character formatting is applied using the features found on the Home tab of 
the Ribbon in the Font group (see Figure 22). 

 
Figure 21 - The Mini Toolbar Figure 22 - Font Group 

Changing Font Typeface 
A font typeface is defined as a group of characters sharing similar type attributes. The default 
font typeface for new documents in Excel 2007 is Calibri. 

To change the font typeface for selected text: 
1. Select the text to change. 
2. Click the Font Typeface drop-down arrow    in the Font group. A list of available fonts 

will appear. 
3. Select the desired font name to change the font typeface. 

Changing Font Size 
Font size refers to the height of printed text on a page and is measured in units called points. 
There are 72 points in one inch. The higher the number entered for the font size, the larger the 
text will be. The default font size for new documents in Excel is 11 points. 

To change the font size for selected text: 
1. Select the text to change. 
2. Click the Font Size drop-down arrow  in the Font group. A list of available font sizes 

will appear. 

NOTE: Font sizes are not listed in increments of one point. If a desired font size is not listed in the 
Font Size drop-down list, click the number instead of the drop-down arrow, manually enter the 
desired font size and press the [Enter] key to apply the new font size. 

3. Select the desired font size. 

Changing Font Style 
Font style refers to font type enhancement. See Table 3 for examples of the available font styles.  
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Table 3 - Font Styles 
Button Font Style Example

 
Bold  Example of Bold text 

 
Italic  Example of Italicized text 

 
Underline  Example of Underlined text 

NOTE: It is possible to apply more than one font style to text. 

CHANGING FONT COLOR 
Two aspects of font color can be styled. The background color of the text (also known as the Fill 
Color) can be changed from the default color of white and the color of the font itself can be 
changed from the default color of black. 

To change the Fill Color for selected text: 
1. Select the text to change. 

2. Click the Fill Color drop-down arrow on the Fill Color button    in the Font group. 
The available highlight colors will appear (see Figure 23). 

3. Select the desired color. 

To change the Font Color for selected text: 
1. Select the text to change. 
2. Click the Font Color drop-down arrow on the Font Color button    in the Font group. 

The available font colors will appear (see Figure 24). 
3. Select the desired color. 

NOTE: Once a color has been selected for either of the styles, it will remain selected until changed. 
To apply the same color to different text in the document, highlight the text and click the Font Color 
button or the Fill Color button. 

 
Figure 23 - Fill Colors 

 
Figure 24 - Font Colors 

RESIZING AND FORMATTING CELLS 
The user can change the size of the columns and rows to make them more appropriate.  
Formatting cells can improve the appearance of the worksheet. 
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Changing Column Width 
A cell entry can contain up to 32,768 characters.  By default, column width is 8.43 characters.  If 
the user enters a value that does not fit within the column width, the characters “spill over” into 
the next column cells (see Figure 14) (appears to occupy the cell(s) to the right).  A number that 
does not fit within a column is displayed as a series of pound signs (#####).  To accommodate 
the length of data in a cell, change the width of a column. 

To change a column width: 
1. Position the mouse pointer between column headers.  The pointer will change to a two-

direction arrow with a vertical line through it  . 
2. Hold down the left mouse button and drag the line to the right or left. 

To set the width of the column to fit the widest cell: 
1. Move the pointer between the column header of the column to adjust and the column 

header immediately on the right. 
2. Double-click the left mouse button. 

Changing Row Height 
Row height is automatically adjusted to accommodate larger font sizes, but users may also adjust 
them manually. 

To adjust a row height: 
1. Position the mouse pointer between row headers.  The pointer will change to a two-

direction arrow with a horizontal line through it  . 
2. Hold down the left mouse button and drag the line up or down. 

Changing Alignment 
To change the alignment of the text in the cell(s): 

1. Select the cell(s) to change. 

2. Click the Left   , Center   , or Right   align 
buttons in the Alignment group. 

Creating Cell Borders 
Adding a border to selected cells or cell ranges is a convenient 
way to distinguish those cells from others. 
To select cell borders: 

1. Select the cell or cell range around which to place a 
border. 

2. Click the Borders drop-down arrow in the Font group 
(see Figure 22). 

3. Select the desired border (see Figure 25). 
 

Figure 25 - Border Drop-down 
Menu 

FORMATTING NUMBERS 
Cells can be formatted to change the appearance of a number in a cell.  Formatting modifies the 
appearance of the worksheet.  Using formatting, the user can add features such as dollar signs 
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($), percent symbols (%), commas (,), and the fixed number of decimal places that will be 
displayed. 

NOTE: Formatting does not change the underlying value of any number.  The value will still be used in 
calculations. 
To format a currency value: 

1. Select the cell or range of cells to 
format. 

2. Click the Accounting Number 
Format button    in the Number 
group. 

 
Figure 26 - Accounting Number Format Drop-down 

Menu 

NOTE: If currencies other than U. S. dollars are needed, click the Accounting Number Format 
drop-down arrow and select a currency from the list of options (see Figure 26). 

To format a cell in a percent style: 
1. Select the cell or range of cells to format. 
2. Click the Percent Style button    in the Number group. 

To format a cell in a comma style that denotes units of thousands: 
1. Select the cell or range of cells to format. 
2. Click the Comma Style button    in the Number group. 

To increase the number of decimal places in a number: 
1. Select the cell or range of cells to format. 
2. Click the Increase Decimal button    in the Number group. 

To decrease the number of decimal places in a number: 
1. Select the cell or range of cells to format. 
2. Click the Decrease Decimal button    in the Number group. 

Using Simple Formulas 
Excel allows users to perform sophisticated calculations and create formulas.  The advantage of 
using formulas is that when data in the worksheet changes, all the formulas are recalculated and 
the results displayed automatically.  This feature assists in developing budgets, forecasting 
models, creating sales plans, estimating marketing projections, calculating invoices, generating 
banking statements, or any other applications that may involve formulas and functions.  
Formulas begin with an equal sign (=) because they contain cell addresses. The equal sign 
prevents Excel from interpreting the formula as text, since text addresses begin with letters. 

USING AUTOSUM 
Excel has built-in functions that are shortcuts for formulas.  The most commonly used function is 
the Sum function, which calculates the total of the values in a range of cells. The AutoSum 
button in the Editing group on the Home tab of the Ribbon is a shortcut to enter the formula in 
the active cell.  AutoSum is an easy way to sum values in a row or column of a worksheet. 
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Figure 3 - Format Cells Dialog Box 

 
Figure 4 - Orientation & Text Control 

Wrapping Text in a Cell 
When text exceeds the length of the cell, it may display in the adjacent cell. In this case, Excel 
can wrap the text into one cell without adjusting the column width. 

To wrap a text in a cell: 
1. Select the cell or range of cells to wrap. 
2. Select the Home tab on the Ribbon. 
3. Click the Alignment dialog box launcher  . The Format Cells dialog box opens (see 

Figure 3). 
4. Select the Alignment tab. 
5. Under the Text Control section, check the Wrap text check box. 
6. Click the OK button. 

NOTE: The text can be restored to its original format by deselecting the Wrap text check box. 

Shrinking Text in a Cell 
Besides wrapping, Excel can decrease the size of the text allowing it to fit into a cell without 
spilling over to the next cell. 

To shrink text to fit in a cell: 
1. Select the cell or range of cells to shrink the text. 
2. Select the Home tab on the Ribbon. 
3. Click the Alignment dialog box launcher  . The Format Cells dialog box opens (see 

Figure 3). 
4. Select the Alignment tab. 
5. Under the Text Control section, check the Shrink to fit check box. 
6. Click the OK button. 

NOTE: The text can be restored to its original format by deselecting the Shrink to fit check box. 
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Merging Multiple Cells into One Cell 
Often a heading or title in Excel appears to occupy several cells, when in fact it is only 
occupying one. Without having to alter the width of a cell, cells can be combined or merged with 
adjacent cells to allocate a larger area in order to accommodate the titles. 

To merge a range of cells into one cell: 
1. Drag to select the cells to merge. 
2. Select the Home tab on the Ribbon. 
3. Click the Alignment dialog box launcher   . The Format Cells dialog box opens (see 

Figure 3). 
4. Select the Alignment tab. 
5. Under the Text Control section, check the Merge cells check box. 
6. Click the OK button. 

NOTE: Merging cells can also be performed by selecting the Alignment group on the Home tab of the 
Ribbon, clicking the Merge and Center drop-down arrow, and selecting the appropriate option (see 
Figure 5). 

Using Cell Styles 
Formatting data using predefined styles provides a consistent look to the worksheet and can be 
useful for visually organizing data. Cell styles provide different colors, shadings, and font effects 
to the cells where the style is applied. 

 
Figure 5 - Merge and Center Drop-down Menu 

 

 
Figure 6 - Styles Group 

To apply a Cell Style: 
1. Drag to select the range to format. 
2. Select the Home tab on the Ribbon. 
3. Click the Cell Styles drop-down arrow (see Figure 6). 
4. Select the style from the drop down menu (see Figure 7). 

NOTE: Users can define custom cell styles by selecting the    option in the Cell Styles 
drop-down menu and setting the style options.  
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Figure 7 - Cell Styles Drop-down Menu 

Applying Conditional Formatting 
There may be times when it is necessary to format cells in a particular style if the cell content 
meets certain conditions. For example, users may want to bold and italicize all values greater 
than 100 in order to emphasize them. Excel can format the numbers to the user’s specification 
based on the contents of the cells. In addition, Excel 2007 provides three new conditional 
formats that are discussed below. 

To apply Conditional Formatting: 
1. Drag to select the range to format. 
2. Select the Home tab on the Ribbon. 
3. Click the Conditional Formatting drop-down arrow (see Figure 6). 
4. Select the type of condition desired. Each type of condition will require the user to enter 

different parameters to specify the condition and the format applied if the condition is 
met. 

NOTE: Figure 8 is a representative example of a conditional formatting dialog box. Each conditional 
formatting dialog box contains the criteria and six pre-defined conditional formats (see Figure 9). 
Users also have to ability to create their own conditional formats by selecting the    
option. 

 
Figure 8 - Example Conditional Format Dialog Box 
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The Highlight Cells Rules option (see Figure 10) applies logical math operators (>, <, =) as well 
as text and date search criteria to the range of cells selected by the user. The Top/Bottom Rules 
option (see Figure 11) applies criteria to the selected cells based on the relative rankings of the 
data in each cell. Even though the menu specifies “10 Items” or “10%” for the options available, 
the user is able to customize the actual percent or number of items to be considered when 
defining the condition (see Figure 12). 

 
Figure 9 - Pre-defined Conditional Formats 

 
Figure 10 - Highlighted Cell Rules Options 

 
Figure 11 - Top/Bottom Rules Options 

 
Figure 12 - Example Top/Bottom Rules Dialog Box 

Data Bars are the first of the three new conditional formats incorporated into Excel 2007. Data 
Bars examine the range of values in the selected cells and apply a visual format in each cell 
based on the relative weight of the cell compared to the maximum value in the cells selected. 
Figure 13 shows the options available when the Data Bars option is selected. Figure 14 shows a 
group of cells where the Purple Data Bar has been applied. The values in the cells ranged from 
“0” to “4.” 

The Color Scales conditional format option applies a color gradient scheme to the range of cells 
selected. Each value in the range of cells selected receives its own color. Cells with equal values 
have the same color. Figure 15 shows the options available when the Color Scales option is 
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selected. Figure 16 shows a group of cells where a Red-Yellow Color Scale has been applied. 
The values in the cells ranged from “0” to “4.” 

 
Figure 13 - Data Bar Options 

 
Figure 14 - Cells with the Purple Data Bar Applied 

 

 
Figure 15 - Color Scales Options 

 

 
 
 

 
Figure 16 - Cells with the Red-Yellow Color Scale Applied 

The third of the new conditional format options are the Icon Sets. Icon Sets associate sets of 
icons with data values in the selected range of cells. Each value has its own symbol. Figure 17 
shows the options available when the Icon Sets option is selected. Figure 18 shows a group of 
cells where the 5 Ratings Icon Set has been applied. The values in the cells ranged from “0” to 
“4.”

 
Figure 17 - Icon Set Options 

 
Figure 18 - Cells with the 5 Ratings Icon Set 

Applied 
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Managing Worksheets 
Worksheets in previous versions of Excel contained 65,536 rows and 256 columns, with a single 
workbook containing up to 1,024 worksheets. Excel 2007 has greatly expanded the amount of 
information that can be stored in a workbook. Each workbook is still limited to 1,024 
worksheets, but each worksheet is now capable of containing 16,385 columns and 1,048,576 
rows. Consequently, navigating within a worksheet and between various worksheets can be quite 
difficult. To simplify this process, Excel provides freeze panes, scroll bars, and navigation 
buttons. 

USING LARGE WORKSHEETS 
Occasionally a worksheet is so large that it is difficult to view the column and row headings and 
all the data at the same time because the row and column headings scroll out of view. To solve 
this problem, Excel allows freezing worksheet titles in panes. Freezing panes prevents the row 
and column headings from scrolling out of view while navigating the worksheet. 

To freeze panes: 
1. Select the View tab on the Ribbon. 

NOTE: If it is desired to freeze both a set of rows and columns then the cell below the row and to the 
right of the column to be frozen must be selected first.  

2. Click the Freeze Panes drop-down arrow.  
3. Select appropriate option from the menu (see Figure 19). 

To unfreeze panes: 
1. Select the View tab on the Ribbon. 
2. Click the Freeze Panes drop-down arrow.  
3. Select the Unfreeze Panes option (see Figure 20) 

NOTE: When a portion of the worksheet is frozen, the frozen pane is indicated by a solid dark line 
separating it from the rest of the cells.

 
Figure 19 - Freeze Panes Drop-down Menu 

 
Figure 20 - Unfreezing Panes 

WORKING WITH MULTIPLE WORKSHEETS 
Excel provides various features that allow easy access to and management of multiple 
worksheets. These features allow navigating to view the content of each worksheet and also 
modify its contents. 

Inserting Worksheets 
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New worksheets are inserted by clicking the Insert Worksheet tab on the right side of the last 
worksheet in the workbook (see Figure 21) 

NOTE: A worksheet can also be inserted by right-clicking any worksheet name tab, selecting the   
option, then choosing “Worksheet” in the dialog box. Any worksheet inserted this way will appear to the 
left of the worksheet that was selected. 

 
Figure 21 - Insert New Worksheet Button 

 
Figure 22 - Rename Worksheet 

Renaming Worksheets 
If a workbook contains several sheets, the sheet names (on the sheet tabs) are important for 
identification purposes. When renaming worksheets, it is best to assign a name that is relevant to 
the information it holds. 

To rename a worksheet: 
1. Double-click the tab of the sheet to rename. The sheet name will be highlighted (see 

Figure 22). 
2. Enter the new name, and press the [Enter] key. 
OR 
1. Right-click the tab of the sheet to rename ► Rename. 
2. Enter the new name and press the [Enter] key. 

Navigating Between Worksheets 
The active worksheet is the worksheet that is currently displayed. A worksheet can be displayed 
by clicking its tab; however, if there are too many worksheets, the user may not be able to view 
every tab at once. For example, in a workbook that contains worksheets for every month of a 
year, the tabs for the last few months of the year may be hidden (see Figure 23). 

 
Figure 23 - Worksheet Tabs 

Excel provides the worksheet navigation buttons listed in Table 1 to navigate between the 
worksheets tabs. 

Table 1 - Navigation Buttons 
Button Function 

   Displays the first worksheet tab in the workbook. 

   Displays the previous worksheet tab to the left. 

   Displays the next worksheet tab to the right. 

   Displays the last worksheet tab in the workbook. 
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Selecting Worksheets 
There is always an active worksheet in any given workbook. For instance, in Figure 23 the 
“April” worksheet is the active sheet. However, users can activate or select more than one sheet 
in a single workbook. Activating several worksheets is useful when it is necessary to format or 
print several worksheets simultaneously rather than formatting or printing them individually. 
Excel offers two options to select both single and multiple worksheets. Depending on the 
preference, users can select adjacent or non-adjacent worksheets. 

Single worksheets are activated by clicking the worksheet name tab. The active sheet will appear 
white rather than gray. 

NOTE:  A shortcut menu can be used to select a sheet that is not visible. 

To activate the shortcut menu: 
1. Right-click in the area where the 

worksheet navigation buttons are 
located. A list of all worksheets will 
appear (see Figure 24). 

2. Select the worksheet to activate. The 
list will disappear and the chosen 
worksheet will activate. 

 
Figure 24 - Selection through Shortcut 

The  key combinations for navigating through different worksheets are: 
• [Ctrl + Page UP]: activates the previous sheet (if there is one). 
• [Ctrl + Page Down]: activates the next sheet (if there is one). 

NOTE:  Excel’s menus are context sensitive. Right-clicking to view the shortcut menus or lists may 
show different results depending on the area of the Excel window that is selected. 

To select multiple adjacent worksheets: 
1. Click the tab of the first worksheet to select. The worksheet will appear, and its tab is 

selected. 
2. Hold down the [Shift] key and click the tab of the last adjacent worksheet to select.  All 

of the worksheets in between are now selected. 
3. Click on any unselected tab to deselect the worksheets. 

To select multiple non-adjacent worksheets: 
1. Click the tab of the first worksheet to select. The worksheet will appear, and its tab is 

selected. 
2. Hold down the [Ctrl] key and click the tab of the next worksheet to select. 
3. Click another non-adjacent tab to select while still holding down the [Ctrl] key.  The 

non-adjacent tabs are now selected and active. 
4. Release the [Ctrl] key and click on any unselected tab to deselect the worksheets. 

WORKING BETWEEN WORKSHEETS 
It is important that the workbook demonstrate order, relevance, and a proper logical flow for 
others to easily understand and navigate between the worksheets. To achieve this purpose, use 
methods such as copying and moving worksheets within the workbook. 
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Copying a Worksheet 
When working with data (monthly expenses or income for example), the user may find a series 
of information that is constant for all the worksheets. Excel allows copying a worksheet to 
eliminate retyping. When a worksheet is copied, all the data, formulas, attributes, and page 
layouts are also copied. 

To copy a worksheet: 
1. Select the tab of the worksheet to copy. 
2. Hold down the [Ctrl] key and click and hold the mouse pointer on the tab of the sheet to 

be copied.  A paper symbol with a “+” sign on it and a small black triangle pointing down 
appears.  The “+” indicates that the sheet is copying. The black triangle indicates the 
location of where the worksheet will be copied to (see Figure 25). 

3. Drag the worksheet to the desired location and release the mouse. 

 
Figure 25 - Copying a Worksheet  

Figure 26 - Copied Worksheet 

NOTE:  Once the worksheet has been successfully copied, the duplicated sheet’s tab now contains a 
number placed in parenthesis. This indicates that the worksheet is a second or third duplicate of an 
original worksheet (see Figure 26). 

Moving a Worksheet 
It is also possible to rearrange the order of worksheets by moving the sheet to the desired 
position. Unlike copying, moving does not replicate the sheet but simply moves the sheet from 
one location into another. 

To move a worksheet: 
1. Select the tab of the worksheet to move. 
2. Click and hold down the mouse button on the worksheet tab. A small black triangle 

appears indicating the position where worksheet will be moved if the mouse is released. 
3. Drag the selected worksheet tab to the desired location. 

Copy Data between Worksheets 
When working with Excel data, the user may copy selected information from one worksheet and 
paste it into another. When making a copy of data, Excel copies not only the data but also its 
accompanying formulas and formatting attributes. 
 
To copy data: 

1. Highlight the data to copy. The highlighted area will be shaded. 
2. Select the Home tab on the Ribbon 
3. Click the Copy button      in the Clipboard group. A blinking marquee surrounding 

the range of cells will appear. 
4. Select the destined worksheet to which the information will be copied. 
5. Click the first cell in the range where the copied data should be pasted. 
6. Click the Paste drop-down arrow. 
7. Select Paste from the menu (see Figure 27). 
8. Click the original worksheet tab and press the [Esc] key. The blinking marquee will be 

removed. 
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Figure 27 - Paste Drop-down Menu 

Creating and Modifying Charts 
Creating charts is one of the most powerful features in Excel. A chart uses values in a worksheet 
to create a graphical representation of their relationship. With Excel charts, the user can 
summarize, highlight, or reveal trends in the data that might not be obvious when simply looking 
at the numbers. When creating a chart, each column of data on the worksheet will make up a data 
series. Each individual value within the row or column is called a data point. 

Previous versions of Excel used what was called a Chart Wizard that assisted the user in 
creating a chart through a series of dialog boxes that allowed choosing options for the chart. 
Excel 2007 does not use the Chart Wizard any longer. Instead, after a chart has been created the 
user is presented with three contextual tabs that allow modifications to be made. 

To create a chart: 
1. Highlight the data that will be charted. The highlighted area will be shaded. 
2. Select the Insert tab on the Ribbon 
3. Click the chart category drop-down arrow for the appropriate chart sub-type in the Charts 

group (see Figure 28). 
4. Select the chart sub-type from the drop-down menu (see Figure 29). The chart will be 

created and embedded in the active worksheet. 

 
Figure 28 - Charts Group 

 

 
Figure 29 - Column Drop-down Menu (Partially 

Shown) 
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Figure 30 - Insert Chart Dialog Box 

NOTE: The user may also click the Charts dialog box launcher     to open the Insert Chart dialog 
box and select the chart type from there (see Figure 30). 

As an example, Figure 31 is sample data that was used to create the chart represented in Figure 
32. 

 
 

Figure 31 - Sample Data Used to Create Chart 

 
Figure 32 - Chart Created from Data in Figure 31 
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IDENTIFYING CHART OBJECTS 
Excel charts (see Figure 32) contain several elements called objects. Refer to Table 2 for chart 
object descriptions. 

Table 2 - Identifying Chart Object 
Chart Object Description

Chart Area The entire area within the chart borders including 
the chart and all related elements. 

Plot Area The area in which Excel plots data. 

Category Axis (x-axis) The axis that contains the categories being plotted. 
It is usually the horizontal axis. 

Value Axis (y-axis) The axis that contains the values being plotted. It 
is usually the vertical axis. 

Chart Title 
Text describing the chart that is automatically 
centered and placed at the top of the chart. (Not 
shown in Figure 32). 

Legend Describes the data series being plotted. 

Gridlines 
Lines that extend from an axis across the plot area 
to help guide the eye from the data point to its 
corresponding value. 

CHART TOOLS CONTEXTUAL TABS 
Users can modify a chart any time after it is created.  The chart must be activated by clicking or 
selecting it before attempting modifications. The three Chart Tools contextual tabs contain the 
tools necessary to modify and enhance the chart. Contextual tabs are not visible or activated until 
the chart is activated. Figure 33, Figure 34, and Figure 35 identify all of the groups in each of the 
contextual tabs. 

 

 
Figure 33 - Design Contextual Tab Groups 

 

 
Figure 34 - Layout Contextual Tab Groups 
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Figure 35 - Format Contextual Tab Groups 

CHANGING CHART TYPE 
Users can change the chart type anytime after a chart has been created without having to recreate 
it from scratch. 
To change the chart type: 

1. Click anywhere on the chart to activate it. 
2. Select the Design contextual tab on the Ribbon. 
3. Click the Change Chart Type button in the Type group (see Figure 33). The Change 

Chart Type dialog box opens. 

NOTE: The Change Chart Type dialog box is identical to the Insert Chart dialog box shown in 
Figure 30. The only difference between the two is the title. 

4. Find and select the new chart type. 
5. Click the OK button to change the chart type. 

ADDING A CHART TITLE 
By default, charts are not created with titles. The title object must be added after the chart is 
created. 

To add a title to the chart: 
1. Click anywhere on the chart to activate it. 
2. Select the Layout contextual tab on the Ribbon. 
3. Click the Chart Title drop-down arrow in the Labels group (see Figure 34). 
4. Select the appropriate option from the drop-down menu (see Figure 36). 
5. Type the chart title into the text box that appears on the chart. 
6. To format the chart title, click the    option. The Format Chart Title 

dialog box opens (see Figure 37). 
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Figure 36 - Chart Title Drop-down Menu 

 
Figure 37 - Format Chart Title Dialog Box 

MOVING A CHART 
When charts are created, they are automatically embedded in the worksheet where the chart data 
is located. Charts can be moved to their own worksheet or to a different worksheet. 

To move a chart: 
1. Click anywhere on the chart to activate it. 
2. Select the Design contextual tab on the Ribbon. 
3. Click the Move Chart button in the Location group (see Figure 33). The Move Chart 

dialog box opens (see Figure 38). 
4. Select the desired location for the chart and click the OK button. 

 
Figure 38 - Move Chart Dialog Box 

ADDING AND REMOVING GRIDLINES 
Major horizontal gridlines are automatically incorporated into a chart when it is created. Both 
horizontal and vertical gridlines (major and minor) can be added, removed, or modified at any 
time. 

To modify horizontal gridlines: 
1. Click anywhere on the chart to activate it. 
2. Select the Layout contextual tab on the Ribbon. 
3. Click the Gridlines drop-down arrow in the Axes group (see Figure 34). 
4. Select the    option from the drop-down menu 
5. Select the appropriate option from the menu (see Figure 39). 
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NOTE:  Selecting    opens the Format Major Gridlines dialog 
box and allows the user to format the appearance of the horizontal gridlines. 

 
Figure 39 - Horizontal Gridline Options

 
Figure 40 - Vertical Gridline Options

 

To modify horizontal gridlines: 
1. Click anywhere on the chart to activate it. 
2. Select the Layout contextual tab on the Ribbon. 
3. Click the Gridlines drop-down arrow in the Axes group (see Figure 34). 
4. Select the    option from the drop-down menu 
5. Select the appropriate option from the menu (see Figure 40). 

NOTE:  Selecting    opens the Format Major Gridlines dialog 
box and allows the user to format the appearance of the vertical gridlines. 

MODIFYING THE CHART LEGEND 
When a chart is initially created, the chart legend is automatically placed on the right side of the 
chart. Users are given the capability of relocating the legend to a different position and 
formatting it. 

To modify the chart legend: 
1. Click anywhere on the chart to activate it. 
2. Select the Layout contextual tab on the Ribbon. 
3. Click the Legend drop-down arrow in the Labels group (see Figure 34). 
4. Select the appropriate option from the Legend drop-down menu (see Figure 41). 

NOTE: Selecting      opens the Format Legend dialog box and allows the user to 
format the appearance of the chart legend. 
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Figure 41 - Legend Drop-down Menu 

Using Formulas and Functions 
Formulas are used to perform calculations on values entered into the cells of a worksheet. A 
formula consists of values or text, arithmetic operators, cell addresses, and worksheet functions 
used to calculate a value in a cell (see Table 3). The major advantage of Excel lies in the 
capability of the application to automatically adjust and recalculate a formula when the value of 
a cell used in the formula changes. 

Table 3 - Formula Components 
Component Description

Operators Tells Excel which math operation or comparison to 
perform 

Cell Reference/address Individual cells (A1, A2), and cell ranges (A1: 
D10 ) 

Values or text The content of the cell 

Worksheet functions SUM, AVERAGE, COUNT, MAX, etc. 

Excel provides a variety of operators and worksheet functions for creating simple formulas. In 
addition to the operators listed in Table 4, Excel has several built-in functions that enable the 
user to perform more operations. 

Table 4 - Mathematical and Logical Operators 
Operator Name 
+ Add 
- Subtract 
* Multiply 
/ Divide 

( ) Controls the order of operation. 
Calculations within parentheses are performed first. 

% Converts the number into a percentage. For example, when typing 
0.10, Excel reads the value as 10% 

^ Exponent. For example, when typing 2^3,  
Excel reads the value as 2*2*2 or 2 to the third power 

= Logical comparison (equal to) 
> Logical comparison (greater than) 
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< Logical comparison (less than) 
>= Logical comparison (greater than or equal to) 
<= Logical comparison (less than or equal to) 
<> Logical comparison (not equal to) 

CREATING FORMULAS 
Formulas can be as simple as using the AutoSum function or complex using multiple operators.  
When using multiple operators, Excel uses the standard mathematical order of precedence to 
determine which operations are carried out first. 

NOTE: Formulas must always begin with the equal “=” sign.  The equal sign prevents Excel from 
interpreting the formula as text, since cell addresses begin with letters. 

The order of precedence is as follows: parentheses, exponents, multiplication and division, then, 
addition and subtraction.  For example, the result of “=(8*5)+10” is 50 and the result of 
“=8*(5+10)” is 120. 

Entering Formulas 
Formulas are entered in the cell where the result will appear.  Cell addresses can either be typed 
or the mouse can be used to select the cells used in the formula (this allows Excel to enter the 
cell addresses into the formula automatically).  Users must still manually enter the operator type 
appropriate to the formula used. 

To enter a formula: 
1. Type the [=] sign inside the cell where 

the result should appear (see Figure 42). 
2. Select the cell holding the value to be 

evaluated by the formula.  A marquee 
will surround the selected cell; and the 
cell address is automatically inserted in 
the target cell. 

 
Figure 42 - Entering a Formula 

 

NOTE: The marquee surrounding a cell will be color coded and will correspond to the cell address in the 
formula. 

3. Use the appropriate operator (+, -, *, /…). 
4. With the mouse pointer, select the second cell to be evaluated by the formula.  A marquee 

will surround the selected cell. 
5. Press the [Enter] key. The formula result is placed inside the cell. 

NOTE: Once the calculation takes place, the target cell will show the result of the computation.  To 
make corrections inside the formula, either double-click the cell holding the final result or make the 
changes in the Formula Bar. 

Copying Formulas 
Once a formula is defined and the result calculated, Excel allows copying the formula to other 
cells without defining the same formula repeatedly.  The user may calculate just one cell and 
copy the formula to the adjacent cells. 
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To copy a formula: 
1. Select the cell that holds the formula.  For example, cell G5 in Figure 42 is the cell 

holding the formula. 
2. Position the cursor on the Fill Handle (looks like a small black square) located on the 

bottom right corner of the cell.  The cursor will change to a cross without arrows. 
3. Hold and drag the Fill Handle until the range of cells where the formula will be copied 

are enclosed.  The results of the calculations are automatically placed in each cell. 

RELATIVE VERSUS ABSOLUTE REFERENCES 
There are two types of cell references in Excel: relative and absolute.  The difference between 
absolute and relative cell references becomes apparent when copying formulas from one cell to 
another.  When copying a formula containing relative references, the cell references are adjusted 
to reflect the new location.  Absolute references, however, always refer to the same cell, 
regardless of where the formula is copied.  Relative references are made by default. 

Relative Reference 
In Figure 42 above, when copying the net profit formula to the range D4:D6, Excel does not 
produce an exact copy of the formula; rather, it generates these formulas: 

• Cell D3: =B3 - C3 
• Cell D4: =B4 - C4 
• Cell D5: =B5 – C5 
• Cell D6: =B6 – C6 

Excel adjusts the cell references to refer to the cells that are relative to the new formula. 

Absolute Reference 
Absolute reference, as its name indicates, makes the cell reference absolute or fixed.  The “$” 
symbol is used in conjunction with a cell reference to indicate an absolute reference.  For 
example, to compute the amount of commission earned by a sales person based on the amount of 
sales that person made, the user would make the cell holding the percentage amount of 
commission absolute and keep the cells holding the individual sales amount relative.   
There is also the option of making only the column or row absolute by applying a mixed 
reference (see Table 5). 

Table 5 - Reference Type 
Cell 
Entry 

Types of 
Referencing 

Result

C1 Relative Both the column and row will change when copied to 
another location. 

$C1 Mixed The column will not change when copied to another 
location, but the row will. 

C$1 Mixed The row will not change when copied to another 
location, but the column will. 

$C$1 Absolute Both the column and row will not change when copied 
to another location. 

To make a cell reference absolute:  
1. Select the cell where the results are to appear. To calculate the sales commission in 

Figure 43 below, cell I5 will be the target cell. 
2. Type the equal sign [=] to indicate the beginning of a formula. 
3. Enter the cell address holding the number used in the calculation (E5 in this example). 
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4. Type the appropriate operator. 
5. Type the [$] symbol in front of the column letter and another in front of the row number 

to make the cell absolute ($H$1). 
6. Press the [Enter] key. The result will appear in the target cell. 

 
Figure 43 - Absolute Reference 

After copying the formula to other cells, the cell and/or column reference that was made absolute 
will not change while the reference that was relative will adjust itself with the changing cells.  In 
this example:  

• Cell I6 =E6*$H$1 
• Cell I7 =E7*$H$1 
• Cell I8 =E8*$H$1 
• Cell I9 =E9*$H$1 

Insert Function 
When working with complex formulas and functions, the user may not be sure of the proper 
syntax of the function.  Excel provides a feature that ensures the correct entry of a function and 
its arguments.  The Insert Function dialog box contains several arguments that are grouped by 
functions in order to narrow the selection. Use the Insert Function feature to ensure that the 
function is spelled correctly and has the arguments in the correct order. 

To insert a formula using the Insert Function feature: 
1. Select the cell where the result will appear. 
2. Select the Formulas tab on the Ribbon. 
3. Click the Insert Function button (see Figure 44). The Insert Function dialog box opens 

(see Figure 45). 
4. Select an option from the Or select a category: list box. The list box provides the broad 

categories of functions available in Excel. 
5. Select a function in the Select a function: section. A brief description of what the 

function does is displayed beneath this section. 
6. Click the OK button. The Formula Arguments dialog box will open (see Figure 46). 
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Figure 44 - Insert Function Button 

 

 
Figure 45 - Insert Function Dialog Box 

 
Figure 46 - Average Calculation Function 

 
7. Specify a range of arguments for the function by clicking the Collapse Dialog button  

. The Formula Arguments dialog box is temporarily collapsed to a thin box. 

NOTE: It is also possible to use the mouse and drag the range of cells that will be used instead of 
clicking the Collapse Dialog button. 

8. Select a range of cells in the worksheet containing the values to be used in the function.  
A blinking marquee surrounds the range of cells and their cell addresses appears in the 
collapsed box. 

9. Click the Collapse Dialog button    to redisplay the Formula Arguments window. 
10. Click the OK button. The result of the operation is inserted in the target cell. 

NOTE: To include more than one argument in the calculations, click the second collapse dialog 
button and select the range of cells. 

USING ADVANCED FUNCTIONS 
Another key advantage of using Excel functions are their decision-making capabilities.  Logical 
functions make decisions based on criteria. If the evaluated criteria are true, then one action is 
taken. If the evaluated criteria are false, then a different action is taken. 

For example, if a company has a policy of giving discounts to customers that place an order 
greater than a specified amount, the use of advanced functions can determine the number of 
customers that meet the criteria. This decision-making capability of logical functions can be 
applied to many different situations. 
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Using the IF Function 
One of the most important and frequently used functions available in Excel is the IF function. 
The IF function returns one value if a condition is true and another value if a condition is false. 
In the above example, if the amount of the order is greater than a set value, then a true value 
would be returned. If the order amount were less than the set value, then a false value would be 
returned. 

The syntax of an IF Function is: =IF(logical test, value if true, value if false) 

The components of the formula are listed in the following table: 

Table 6 - IF Function Components 
Component Description 
Logical test The test condition can contain cell references, text in 

quotes, cell names, and numbers. The items are  
compared using the following comparison operators: 
= equal to 
<> not equal to 
> greater than 
>= greater than or equal to 
< less than 
<= less than or equal to 

Value if true The result produced if the logical test is true. 
Value if false The result produced if the logical test is false. 

Some examples of the IF function are listed in the following table: 

Table 7 - IF Function Examples 
IF Function Result
=IF(B7>10,C7*.08,0) If the number in cell B7 is greater than 10, 

multiply the number in cell C7 by .08. Otherwise, 
return the number 0. 

=IF(B7<=10,C7*.08,D7*.08) If the number in cell B7 is less than or equal to 
10, multiply the number in cell C7 by .08. 
Otherwise, multiply the number in cell D7 by .08. 

=IF(B7<>10, “GOOD”,”) If the number in cell B7 is not equal to 10, enter 
the text GOOD in the current cell. If the number 
in cell B7 is equal to 10, display a blank cell. 

=IF(B7=“BONUS”,C7=1000,C7) If cell B7 contains the text BONUS, then let the 
value in cell C7 equal 1000, otherwise, use the 
existing number in cell C7. 

Using the AND Function with the IF Function 
The AND function returns a logical value (true or false) depending on the value of its arguments. 
If all its arguments return true, the AND function returns true. If at least one of its arguments 
returns false, the AND function returns false. 

For example, Widgets R Us gives monthly bonuses for sales representative whose monthly sales 
amount is greater than $10,000 and have 3 or more years of experience. If the sales 
representatives fulfill both criteria, they will receive a bonus worth $5,000. Otherwise, they will 
get no bonus. Given this scenario, the function will look like this: 
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Figure 47 - IF Function 

By looking in cell D3 of Figure 47 the user will see that the first sales representative, Martin, S. 
has fulfilled the criteria and thus received the $5,000 bonus.  When the formula is copied from 
cell D4 to D6 by dragging the Fill Handle, the function is evaluated for all of the sales 
representatives. All except Adams, G. are awarded a bonus. 

NOTE: The AND function returns a false value if only one logical test is met.  Therefore, Adams, G., 
although he has 15 years of experience, did not meet the required sales target of $10,000.  Therefore, he 
would not get a bonus. 

Using the OR Function with the IF Function 
The OR function is similar to the AND function, but it returns a true value if at least one of its 
arguments is true; otherwise, it returns a false value.  In Figure 48 below, by using the OR 
function, Adams, G. will receive the bonus of $5,000. 

 
Figure 48 - OR Function 

Copy the formula to the cell range D4:D6.  The user will observe that Adams, G., even though he 
did not meet the sales target of $10,000, still qualifies for the $5,000 bonus on grounds that the 
minimum years of experience needed was exceeded. 
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Using Page Setup Features 
The features on the Page Layout tab of the Ribbon in the Page Setup group (see Figure 30) can 
be used to manage worksheet attributes such as the orientation of the worksheet, the size of the 
margins, and whether or not gridlines appear when the worksheet is printed. 

 
Figure 30 - Page Setup Group 

 
Figure 31 - Page Orientation Drop-down 

Menu 

CHANGING PAGE ORIENTATION 
The user can change the orientation of a worksheet so that it prints either vertically (portrait 
orientation) or horizontally (landscape orientation) on a page.  In portrait orientation (the 
default), the shorter edge of the paper is at the top. 

To change the page orientation: 
1. Select the Page Layout tab on the Ribbon. 
2. Click the Orientation drop-down arrow in the Page Setup group (see Figure 31). 
3. Select either the Portrait or the Landscape option. 
OR 
1. Click the Page Setup dialog box launcher  . The Page Setup dialog box opens (see 

Figure 32). 
2. If necessary, click the Page tab. 
3. In the Orientation section, select either the Portrait or Landscape option button. 
4. Click the OK button. 

Introduction to Microsoft Excel 2007 - 21 

EED 301 - Introduction to MS-Excel 42
eed301udswa.wordpress.com 

eed301udswa@yahoo.com



 
Figure 32 - Page Setup Dialog Box (Page Tab Selected) 

CHANGING MARGINS 
The margins define the printed area on the page.  They control the distance between the edge of 
the paper and the data on the page.  Larger margins reduce the printed area.  If the worksheet is 
smaller than the print areas on the page, the Center on Page section feature can be used as 
described below to center the worksheet between horizontal and vertical margins. 

To change margins: 
1. Click the Margins drop-down arrow in the Page Setup group (see Figure 30).  
2. Select a set of margins from the options available. 
3. If the desired margins are not available, click the    option. The Page 

Setup dialog box will open (see Figure 34). 
OR 
1. Click the Page Setup dialog box launcher  . The Page Setup dialog box opens (see 

Figure 34). 
2. If necessary, click the Margins tab. 
3. Click inside the spin boxes and type in the margins manually, or use the spin box arrows 

to set the margins. 
4. Click the OK button. 
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Figure 33 - Margins Drop-down Menu 

 
Figure 34 - Page Setup Dialog Box (Margins Tab Selected) 

PRINTING WITH GRIDLINES 
By default, Excel will not print the gridlines on the worksheet.  Printing the gridlines may make 
the spreadsheet easier to read because they visibly separate rows and columns.  Excel gives the 
option to print a worksheet with or without gridlines. 

To print with gridlines: 
1. Click the Print check box in the Gridlines section in the Sheet Options group. 
OR 
1. Click the Sheet Options dialog box launcher  . The Page Setup dialog box opens (see 

Figure 34). 
2. If necessary, click the Sheet tab. 
3. Click the Gridlines check box in the Print section. 
4. Click the OK button. 

Printing Worksheets 
After a worksheet is completed, it can be previewed before being printed.  Printing options are 
accessed using the Office Button and hovering the mouse over the Print button (see Figure 37). 
Print Preview allows the document to be viewed as it will be printed. Quick Print sends the 
worksheet directly to the printer and does not allow the user to change any print settings. 
Selecting the Print item opens the Print dialog box. 

PREVIEWING A WORKSHEET 
Before printing, it is recommended to preview a worksheet to see how the data appears on each 
page.  The Print Preview feature shows how the worksheet will look when it is printed. 

To preview a worksheet: 
1. Click the Office Button on the upper left corner of the Excel window. 
2. Hover the mouse over the Print button. 
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3. Click the    menu item. The worksheet opens in the Print Preview window 
(see Figure 39). 

4. To exit Print Preview, select the Print Preview tab of the Ribbon. 
5. Click the Close Print Preview button in the Preview group. 

 
Figure 35 - Print 

Check Box 
Figure 36 - Page Setup Dialog Box (Sheet Tab 

Selected) Figure 37 - Printing Options 

   
Figure 38 - Print Dialog Box 
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Figure 39 - Print Preview Window 

PRINTING THE CURRENT WORKSHEET 
To print one copy of the worksheet that is displayed: 

1. Click the Office Button. 
2. Hover the mouse over the Print button 
3. Click the  menu item. The worksheet will be sent to the printer and printed. 

PRINTING WITH THE PRINT DIALOG BOX 
Multiple printing options are available when using the Print dialog box (see Figure 38). Using 
the Print dialog box allows users to print a range of cells, specific pages or a range of pages, and 
print multiple copies. 

To print a selected range of cells: 
1. Select the range of cells to be printed. 
2. Click the Office Button. 
3. Click the Print button. The Print dialog box opens (see Figure 38). 
4. Click the Selection option button in the Print What section. 
5. Click the OK button. 

To print a specific pages or a range of pages: 
1. Click the Office Button. 
2. Click the Print button. The Print dialog box opens (see Figure 38). 
3. Enter the starting page number of the page range in the From: text box in the Print 

Range section. 
4. Enter the ending page number in the To: text box in the Print Range section. 
5. Click the OK button. 

To print multiple copies: 
1. Open the Print dialog box as described above 
2. Enter the number of copies to print in the Number of copies: spin box in the Copies 

section. 
3. Click the OK button. 
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Selecting Printers 
A printer can be selected by clicking the Name drop down arrow in the Printer section of the 
Print dialog box (see Figure 38) and selecting a printer from the list. 

Closing a Workbook and Exiting Excel 
When finished working on a workbook, the user can close it or exit the Excel program. 

• The Close button located on the 
right side of the Title bar will 
close the Excel application (see 
Figure 40). 

• The Close Window button 
located on the right side of the 
Ribbon will close only the file 
(see Figure 40). Figure 40 - Close Buttons 

A file can also be closed by clicking the Office Button and selecting the    option. 
Additionally, the Excel application can be exited by clicking the Office Button then clicking the 

  button. 

NOTE: If the work has not been saved, selecting any of the close options will result in a warning 
reminding the user to save changes before closing the file or the Excel application. 

Using the Help Function 
Excel 2007 has an extensive Help function to answer any questions the user may have regarding 
the commands and functions of Excel. The Help function includes two components, the 
component that is built in to the Excel application and the online component that is available if 
an active Internet connection is available. The Help function can be activated from the Excel user 
interface by clicking the Microsoft Excel Help button    located in the upper right corner of 
the interface. It can also be activated from any open dialog box by clicking the Help button   
which is located in the upper right corner of all dialog boxes. Clicking either of these buttons will 
open the Help dialog box (see Figure 41). When the dialog box opens, the user is presented with 
a list of general help topics in the Browse Excel Help section (see Figure 41). Clicking on any of 
the links will take the user to more detailed information about that topic. If the topic is not 
present in the Browse Excel Help section, the user can perform a search of the Help function. 

To search the Help function: 
1. Click inside the Search text box (see Figure 41). 
2. Type in a keyword or keywords related to the topic. 
3. Press the [Enter] key. Excel will search the Help function and present the user with a list 

of topics that are most relevant to the search. 
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Figure 41 - Help Dialog Box 

 
Figure 42 - Office Online (Not Activated) 

Figure 43 - Office Online (Activated) 

Online Help 
The Excel Help function can also be used to connect to Office Online. By connecting to Office 
Online, the user can find templates, Clip Art, information about Microsoft Office products and 
more Help topics on the Internet. 
 
To activate Office Online: 

1. Click the    button in the lower right corner of the Help dialog box. 
2. Click the    option (see Figure 42). The status will change to 

.  

To deactivate Office Online: 

1. Click the    button in the lower right corner of the Help dialog 
box. 

2. Click the    option (see Figure 43). The status will change 
to  . 
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